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Overview

WinZip brings the convenience of Windows to the use of ZIP, LZH, ARJ, and ARC files. It
features an intuitive point and click interface for viewing, running, extracting, adding,
deleting, and testing files in archives. Optional virus scanning support is included.

Here's what the magazine reviews say about WinZip:

One of the 20 Must-Have Windows Utilities, Windows User, 6/93
"Archive Manager Extraordinaire", Windows Sources, 5/93
"WinZip 4.0 improves on an already impressive product, making archiving a
simple task for Windows users", Windows User 5/93
WIN100 Award Winner, Windows Magazine, 2/93
"Repeatedly charms you when you have to ZIP and unZIP ...

an excellent Shareware utility" Windows Magazine, 12/92
"Our copy gets quite a daily workout" Windows User 11/92
"The most comprehensive Windows front-end to PKZIP" Ziffnet Threads, 11/92
"Does all your compression chores with ease" Computer Shopper, 10/92
"Must-Have Shareware Treasure" Compute, 10/92
"The perfect Windows interface for LHA, PKZIP, ARC, and your

favorite DOS virus scanner" PC World, 10/92

"Greatly facilitates archive Management" Windows Magazine, 9/92
"Powerful yet Intuitive" PC World, 8/92
"Hot Product" Inside Microsoft Windows, 8/92
"WinApp of the Month" PC Computing, 3/92

WinZip is extremely easy to use! To open an archive simply double click on an archive
listed in the File Manager, drag and drop an archive onto WinZip, or use the standard Open
dialog. The main WinZip window features a list box with the names, sizes, and date/time
stamps of all files in the open archive. This list can be scrolled and sorted on any field. A
tool bar provides fast access to commonly used actions. All options (including window size
and position) can be saved and restored. Extensive context sensitive help is always
available.

Double clicking on a file in the main WinZip window has the same effect as double clicking in
the File Manager. First the file is extracted from the archive. If the file is executable, it is
run. Otherwise, the file is opened by the appropriate application (for example, Windows
Write for *.WRI files) based on standard Windows associations.

The Windows 3.1 Drag and Drop Interface is fully supported. You can drag and drop files
from WinZip to other applications. WinZip will extract the files before dropping them on the
target application. The target application will treat the files as if they had been dropped by
the File Manager. You can also drop archives on WinZip to open them, or drop files on
WinZip to add them to the open archive.

WinZip's unique CheckOut Facility makes it easy to quickly install files in archives. Click on
the CheckOut button to extract all files and create a Program Manager group for all files in
the archive. This group will contain one icon for each file. Double click on an icon to view
the corresponding file with the appropriate application. WinZip will optionally delete the
CheckOut files and Program Manager group.

WinZip 4.1 adds a header and status line to the main window, the ability to create ZIPs that
span multiple disks, better support for external file viewers, a new Add dialog box, and the
ability to easily make CheckOut groups permanent. WinZip 4.0 added support for PKZIP 2.0,
the ARJ file format, 3-D dialog boxes, and the color toolbar. New features introduced in



WinZip 3.2 include Built-in ZIP Extraction and font selection for the list of files in the open
archive. If you modify a file after double clicking on it, WinZip will now offer to update the
archive with the modified file. See the section titled Version History for a complete list of
enhancements.

WinZip requires Windows 3.1 in Enhanced or Standard mode and the Shareware PKZIP and
PKUNZIP product from PKWARE, Inc, LHA.EXE from Haruyasu Yoshizaki, or the Shareware ARJ
product from Robert Jung. WinZip interfaces to several programs to access ARC files and
optionally runs most virus scanning utilities. For details see the section titled System
Requirements. WinZip runs these programs in the background in Windows 386 Enhanced
mode, or as full-screen applications in Standard mode. For more information on this aspect
of the program, see the section titled Enhanced and Standard modes.

WinZip is distributed as Shareware. This means that users are encouraged, subject to
restrictions described in the License Agreement, to share copies of this program with friends,
associates and bulletin boards. Please remember that if you use this software you are
required to pay the registration fee of $29 as described in the section titled
Copyright/License Agreement/Warranty.

This program is produced by a member of the Association of Shareware Professionals (ASP).
ASP wants to make sure that the shareware principle works for you. If you are unable to
resolve a shareware-related problem with an ASP member by contacting the member
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or
problem with an ASP member, but does not provide technical support for members'
products. Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, Ml 49442 or
send a CompuServe message to the ASP Ombudsman at 70007,3536.
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About ZIP, LZH, AR}, and ARC Files

Archives are files that contain other files. Typically the files in an archive are compressed.
Archives usually have file names ending with ZIP, LZH, ARJ, or ARC, depending on how they
were created. Archives make it easy to group files and make transporting and copying
these files faster.

ZIP files are the most common archive format. ZIP files are manipulated by the PKZIP and
PKUNZIP programs from PKWARE, Inc. ZIP files were the only archive format supported in
the first version of WinZip.

LZH files are manipulated by the LHA program from Haruyasu Yoshizaki. LHA won the
October 1991 PC Magazine Editor's Choice award as the best data compression utility.
WinZip version 3.0 added support for the LZH file format, including self-extracting LZH files.

AR] files are another popular archive format. AR] files are manipulated by the ARJ program
from Robert Jung, 2606 Village Road West, Norwood, Massachusetts 02062. WinZip version
4.0 added support for the AR|J file format, including self-extracting AR] files.

The ARC format, developed by System Enhancement Associates, was the first popular PC file
format to support multiple compressed files. The ARC program was originally distributed as
a Shareware program, and the ARC format was the standard file format on most bulletin
boards and other online systems. However, after PKZIP and PKUNZIP were released, the ZIP
format became the new standard for many of these systems. Note: the latest release of
ARC (version 7) is only sold as a commercial (non-Shareware) program.

Since there are still many old ARC files on bulletin boards, WinZip version 2.0 added support
for this format. Since most new files seem to be created in ZIP or LZH format, and there is
no single widely available program to manipulate ARC files, WinZip does not provide facilities
to add to ARC files (all other WinZip functions are supported).

The latest Shareware version of ARC (version 6) provides limited support for subdirectories.
However, because individual files cannot be extracted from ARC files containing
subdirectories and the "extract to" directory cannot be specified, WinZip will not open ARC
files containing subdirectories. | expect this limitation will have negligible effect, since |
have yet to encounter an ARC file containing subdirectories on any BBS. Let me know if this
causes a problem for you.

WinZip supports several programs to extract files from ARC files: the original ARC, ARCE
(also known as ARC-E), PKXARC, and PKUNPAK. See the section titled Installation for more
information on these programs.



Brief Tutorial:
This section provides a brief tutorial on basic WinZip operations. It assumes the following:

- Your system meets the requirements described in the section titled System Requirements
and you have installed WinZip as described in the section titled Installation.

- You know how to use standard Windows features, such as dialog boxes, menus, and the
drag and drop interface. If you are not are familiar with these features, please consult your
Windows documentation.

- You are familiar with the concept of archives. For a description of archives, see the section
titled About ZIP, LZH, ARJ], and ARC files.

Remember that context sensitive help is always available. Press the F1 key at any time to
access the full documentation.

Working with Existing Archives:

The first step is to open an archive. There are several ways to open archives:

a) Double click on the archive in the File Manager.

b) Drag the archive from the File Manager and drop it on the WinZip window.

c) Select Open from the WinZip File pull-down menu, or push the Open button on the toolbar,
and select an archive from the standard Open dialog box.

Once an archive is open, you can select from the operations in the Actions pull-menu. For
example, to extract files, select Extract from the Actions pull-down menu or push the Extract
button on the toolbar. This activates the Extract dialog box. For complete documentation
on these actions, click on the appropriate entry in the Commands and Procedures section in
the Table of Contents.

The CheckOut action is particularly useful when working with an archive you've downloaded
from a bulletin board. Click on the CheckOut button to extract all files in an archive to a
temporary directory and create a Program Manager group for all files in the archive. This
group will contain one icon for each file. Double click on an icon to view the corresponding
file with the appropriate application. When you close the archive, WinZip will offer to delete
the temporary files and group.

Creating Archives:

To create a new archive, select New from the WinZip File pull-down menu or push the New
button on the toolbar. This activates the New dialog box. Enter the name of the archive
you want to create. You can use the Drives and Directories list boxes to choose the drive
and directory where the archive will be created. The names of any existing archives on the
selected drive and directory will be listed to help you choose a name that is not already in
use. Press the OK button to complete your selection.

Normally the Add dialog box will be activated automatically. Simply type the name(s) of the
files you want to add to the new archive and press the Add button. Alternately, you can add
files to an archive by dragging the files from the File Manager and dropping them on the
WinZip window.

This concludes the brief tutorial. For complete documentation, please see other portions of
this help file. If you have questions, feel free to contact the author at the address listed in
the About dialog box.






Copyright/License/Warranty

For ordering information, see the section Ordering Information/Order Form.

WinZip(TM) Copyright (c) 1991-1993 by Nico Mak - All rights reserved.
License Agreement and Warranty Disclaimer

You should carefully read the following terms and conditions before using this software. Use
of this software indicates your acceptance of these terms and conditions. If you do not
agree with them, do not use the software.

Shareware Version

You are hereby licensed to: use the Shareware Version of the software for a 21 day
evaluation period; make as many copies of the Shareware version of this software and
documentation as you wish; give exact copies of the original Shareware version to anyone;
and distribute the Shareware version of the software and documentation in its unmodified
form via electronic means. There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies,
however made; and from distributing the software and/or documentation with other products
(commercial or otherwise) without prior written permission, with one exception: Disk
Vendors approved by the Association of Shareware Professionals are permitted to
redistribute WinZip, subject to the conditions in this license, without specific written
permission.

Unregistered use of WinZip after the 21-day evaluation period is in violation of federal
copyright laws.

Evaluation and Registration

This is not free software. This license allows you to use this software for evaluation
purposes without charge for a period of 21 days. If you use this software after the 21 day
evaluation period a registration fee of $29 is required. Payments must be in US dollars drawn
on a US bank, and should be sent to Nico Mak, P.O. Box 919, Bristol, CT 06011-0919. Credit
card ordering and quantity discounts are available, as described in the section Ordering
Information/Order Form. When payment is received you will be sent a registered copy of
the latest version of WinZip.

One registered copy of WinZip may be dedicated to a single person who uses the software
on one or more computers or to a single workstation used by multiple people.

You may access the registered version of WinZip through a network, provided that you have
obtained individual licenses for the software covering all workstations that will access the
software through the network.

Governing Law

This agreement shall be governed by the laws of the State of Connecticut.

Disclaimer of Warranty

This software and the accompanying files are sold "as is" and without warranties as to
performance of merchantability or any other warranties whether expressed or implied. In



particular, there is no warranty for the optional virus scanning feature (WinZip does not scan
for viruses, it simply runs external programs that claim to perform this function). Because
of the various hardware and software environments into which WinZip may be put, no
warranty of fitness for a particular purpose is offered.

Good data processing procedure dictates that any program be thoroughly tested with non-
critical data before relying on it. The user must assume the entire risk of using the
program. Any liability of the seller will be limited exclusively to product replacement or
refund of purchase price.



WinZipw 4.1 Registration Form/Invoice

Ordering by check: To order by check send this order form and a check to Nico Mak,
P.O. Box 919, Bristol, CT 06011-0919. To print this order form, click on Print Topic in the
File pull-down menu. Alternately, you can print the ASCII text file ORDER.DOC. Payments
must be in US dollars drawn on a US bank. Alternately, you can send international
postal money orders in US dollars.

Credit card ordering: For information on ordering by MasterCard, Visa, American
Express, or Discover by phone, FAX, or CompuServe email, or mail, click here -> Credit Card
Ordering Information.

Ordering with CompuServe's Software Registration Service: enter GO SWREG at the !
prompt and follow the menus. WinZip's registration id is 402.

Site licenses: a site license for WinZip entities an organization to receive one copy of the
distribution package and duplicate the distribution disk for the specified number of copies.

French version: French users please contact AB Soft, Park Burospace #14, 91572 Bievres
Cedex, France, phone 33-1-69-33-70-00 for a French version of WinZip.

Japanese users: Contact P&A Co., Ltd., of Japan 302 Bellwins, 1367-23, Nakagami,
Akishima, Tokyo, 196, Japan Phone: 0425-46-9141 / Fax: 0425-46-9142, for local registration.

Please check one: 5.25" Disk _ 3.5" Disk ____ Eithersize
WinZip Single Copy copies at $29 each =
WinZip Site License

2 to 9 computers: computers at $22 each =

10 to 24 computers: computers at $17 each =

25 to 49 computers: computers at $14 each =

50 to 99 computers: computers at $10 each =
100 to 199 computers: computers at $7 each =

(more than 199 copies are negotiable)

Connecticut residents add 6% sales tax +

Total payment
Prices guaranteed through December 1993.

Name : Date:

Company:

Address:

City, State, Zip:

Country:

Day Phone: Eve:

Electronic Mail address:

How did you hear about WinZip?

Comments:






Credit Card Ordering

To order by MasterCard, Visa, American Express, or Discover, call the Public (software)
Library at 1-800-2424-PsL or 713-524-6394 or send your order by FAX to 1-713-524-6398 or
by CompuServe Email to 71355,470. You can also mail credit card orders to PsL at P.O. Box
35705, Houston, TX 77235-5705.

Nico Mak cannot be reached at the numbers above.
These numbers are for PsL, a credit card order taking service only.

Any questions about the status of the shipment of an order, refunds, registration options,
product details, technical support, volume discounts, dealer pricing, site licenses, etc., must
be directed to Nico Mak, P.O. Box 919, Bristol, CT 06011-0919 or by email to 70056,241 on
CompuServe.



Upgrades from Earlier Versions of WinZip

There are be two ways to upgrade a registered copy of an earlier version of WinZip:

Free upgrade: You can use your registration number to convert a Shareware evaluation
version of WinZip to a registered version that does not display the initial registration
reminder dialog box. Everyone that registered earlier versions of WinZip should already
have received a registration number. If you have not received a registration number you
can obtain one by writing to the address in the WinZip About dialog box. Be sure to include
your name as it appeared on your original WinZip order form.

$10 upgrade: To receive a disk containing the registered version of WinZip 4.1, send a
check for $10.00, along with your name as it appeared on your original order form, to

Nico Mak, PO Box 919, Bristol, CT 06011-0919
Connecticut residents please add 6% sales tax, for a total of $10.60.
Payments must be in US dollars drawn on a US bank.

Due to the low price, upgrades will be handled by mail only.



Support and Questions

Technical support is available at no charge by sending electronic mail to 70056,241 on
CompuServe, to 70056.241@compuserve.com on Internet, to Nico_Mak on BIX, or by
sending US Mail to Nico Mak, P.O. Box 919, Bristol, CT 06011-0919. Registered users have
priority but | will try to answer all questions.

Important: The section titled Determining Whether A Problem Is Caused By A Faulty Video
Driver discusses the most common problem reported by WinZip users.

When reporting problems with WinZip, please include the following information:

1) Is the problem reproducible? If so, how?

2) Did the problem occur when running Windows in Enhanced or Standard mode? You can
determine which mode is active by choosing About in the Program Manager's Help pull-down

menu.

3) If a dialog box with an error message was displayed, please include the full text of the
message.

4) If the problem involves an external program like PKZIP.EXE, LHA.EXE, or SCAN.EXE, what
version of the failing program are you using? Please see the section titled System
Requirements for minimum version numbers for these programs.

Thank you!

Note: You can press F1 at any time while WinZip is active for context sensitive
help.



Quick Start Information

Many people that have used other Windows applications will be able to use WinZip without
reading all the documentation. However, the following sections should be reviewed before
running the program:

- Copyright/License Agreement/Warranty

- System Requirements and Installation

- WinZip Overview and Brief Tutorial

If you've used an earlier version of WinZip, you'll probably want to read the section titled
Version History for a list of the new features.

The section titled Drag and Drop support describes a useful WinZip interface. The section
titled Norton Desktop For Windows will probably be of interest to anyone who uses that
product. If you plan to use a Virus Scanner, be sure to read the section titled Virus Scanner

Configuration.

| also suggest you read the sections titled Hints and Tips and Notes and Background
Information for miscellaneous technical notes and background information.

To learn how to use Help press the F1 key or choose Using Help from the Help menu.



System Requirements, Installation, and Uninstallation

This section has four parts. Click on one of the entries below or use the buttons labeled
">>"and "<<".

- System Requirements
- WinZip Related Files

- Installation
- Uninstallation




System Requirements

- WinZip requires Windows 3.1. WinZip will not run under OS/2 2.0 or the initial release of
0S/2 2.1 due to incompatibilities in 0S/2's emulation of Windows. Also, WinZip is known to
be incompatible with a DOS TSR called "BUFFIT.COM".

- One or more of the following three sets of programs:

1) PKZIP(TM) and PKUNZIP(TM) from PKWARE, Inc. You can download the Shareware version
of these programs from most bulletin boards. The latest version is distributed in the self-
extracting ZIP file PKZ204G.EXE on bulletin boards and PK204G.EXE on Compuserve.
Alternately, you can order them directly from PKWARE (phone 414-345-8699). WinZip has
been tested with PKZIP/PKUNZIP 1.1 and 2.0. It will not work with earlier versions.

2) LHA.EXE, from Haruyasu Yoshizaki. You can download LHA.EXE from most bulletin
boards. The latest version is distributed in the self-extracting LZH file LHA213.EXE. WinZip
has been tested with LHA 2.13 and will not work with earlier versions (in particular, it will not
function with LHARC, the predecessor to LHA).

3) ARJ, from Robert Jung. You can download the Shareware version of ARJ from most bulletin
boards. The latest version is distributed in the self-extracting AR] file ARJ230.EXE. WinZip
has been tested with ARJ 2.3 and will not work with earlier versions.

To (optionally) access ARC files one of the following programs is required:

ARCE.COM and ARC-E.COM version 4.0e - Vern Berg's ARC extraction utility, available on
CompuServe and other bulletin boards. WinZip was not tested with earlier versions.

PKXARC.COM version 3.5 from PKWARE, Inc. WinZip was not tested with earlier versions.
This program is still available on some bulletin boards.

PKXARC.EXE version 3.6 from PKWARE, Inc. This program is still available on some bulletin
boards.

PKUNPAK.EXE version 3.61 from PKWARE, Inc. This program is still available on some
bulletin boards.

ARC.EXE version 5.20 or 6.0 from System Enhancement Associates, Inc. This is the last
version of ARC available as Shareware, and is still available on some bulletin boards.
WinZip was not tested with earlier versions. SEA's address is 925 Clifton Ave., Clifton, NJ
07013.



You can run most virus scanning utilities from WinZip. For important details, see the section
titled Virus Scanner Configuration. Direct support is provided for the McAfee Associates
SCAN.EXE virus scanner. SCAN is available from CompuServe, BIX, and other bulletin
boards. McAfee Associates address is 4423 Cheeney Street, Santa Clara, CA 95054.

Note: Like WinZip, the PKZIP, PKUNZIP, ZIP2EXE, AR}, ARC, PKXARC, and SCAN programs are
not free software. As with all Shareware, if you use these programs you should register
them with the appropriate vendor.



WinZip-Related Files

- README.1ST
- LICENSE.DOC
- WINZIP.DOC

- WINZIP.HLP

- WINZIP.EXE

- WZ.DLL

- WZ.COM

- WZ.PIF

- ORDER.DOC
- FILE_ID.DIZ *
- VENDOR.DOC *
- SETUP.EXE**
- SETUP.INF**

introductory information

license agreement/warranty

extracts from online documentation

documentation in online hypertext help format
required executable

required dynamic link library

required executable

required Program Information File

order form

brief description for bulletin boards

information for Shareware Distributors and Disk Vendors
optional installation program

configuration file used by optional installation program

* items marked with an asterisk are not included in the registered version of WinZip
** items marked with two asterisks are optional and are not included in the Shareware
version distributed on bulletin board systems



Installation

Installation with the SETUP program:

If you received WinZip on a disk with the file SETUP.EXE, you can install WinZip in one of two
ways:

1) Exit Windows, insert the WinZip distribution disk in your floppy drive, type win a:\setup
at the DOS prompt, and press Enter.

2) From the Windows Program Manager, choose Run from the File menu, type a:\setup,
and press Enter.

Installation without the SETUP program:

WinZip is distributed on BBS systems without a SETUP program for faster downloads. If you
received WinZip without the file SETUP.EXE, or wish to perform a manual installation, follow
this easy one time installation procedure:

a) If you have installed a previous version of WinZip, backup and delete all files in your
WinZip directory. Otherwise create a directory to hold the WinZip related files. The
recommended directory name (used in the following instructions) is "C:\WINZIP".

b) Copy all WinZip-related files to this directory. At a minimum you need the following files:
WINZIP.EXE, WZ.DLL, WZ.COM, WZ.PIF, and WINZIP.HLP.

¢) Run WINZIP.EXE in one of these three ways:
1) Exit Windows, type win c:\winzip\winzip at the DOS prompt, and press Enter.

2) From the Windows Program Manager, choose Run from the File menu, type c:\winzip\
winzip, and press Enter.

3) Double click on WINZIP.EXE in the Windows File Manager.

That's all there is installing WinZip. When WinZip is activated for the first time, the
Welcome and Configuration dialog boxes are automatically displayed, and you are ready to
go. Remember that while WinZip is active, online help is always available by pressing F1.

Notes:

1) The first time WinZip is run, it will offer to add a WinZip icon to your Program Manager
Accessories Group. Choose Yes in response to this question unless you want to add the icon
yourself (the Accessories Group is merely a default location for the icon - you can drag it to
any other group like any other Program Manager icon). Once this is done, you can start
WinZip by double clicking on the WinZip icon in Program Manager. Alternately, you can
open an existing archive from the File Manager by double clicking on the file.

2) WIN.INI associations for files with an extension of "ZIP", "LZH", "ARJ", and "ARC" are set up
by the automatic installation procedure so that you can start WinZip by double clicking on
the icons for these files while running the File Manager. For more information on
associations, see the section titled Windows Associations.




Uninstallation
You can uninstall WinZip as follows:

1) Delete the WinZip related files listed above. If you installed these files in a directory
containing no unrelated files, you can delete the entire directory.

2) Delete the WinZip icon from your Program Manager group(s). Click on the icon once and
press the Del key. When asked whether you really want to delete the icon, choose Yes.

3) Delete the file WINZIP.INI from your Windows directory.

4) Optionally delete the WinZip entries from your WIN.INI file. This will save less than 1K of
disk space, so do not perform this step unless you are comfortable modifying your Windows
configuration files. If you proceed, first make a backup copy of the WIN.INI file in your
Windows directory. Next open WIN.INI with NOTEPAD. Search for the string [WinZip] (note
the brackets in the search string). Delete all lines until you encounter a left bracket in
column one of a line or until you reach the end of the file, whichever comes first. Then
search for the string WINZIP.EXE. Delete any lines containing this string. Finally save the
modified WIN.INI to disk.



Norton Desktop For Windows

WinZip has been fully tested with Norton Desktop for Windows (NDW), and includes the
following NDW-specific features:

- WinZip enables use of the NDW 2.0 extensions to the Windows 3.1 Drag and Drop Interface
to add files to archives and to open archives. Note that this interface is not provided by
NDW 1.0.

- WinZip's CheckOut feature will activate NDW (version 1.0 or 2.0) if NDW is installed as your
Windows shell.

- You can use the right mouse button to select multiple non-adjacent entries in the main
WinZip list box, just as you can use it in NDW's File Manager.

- WinZip supports the Norton Anti-Virus (NAV.EXE) program distributed with NDW.



Drag and Drop Interface
The Drag and Drop Interface provides a convenient way to:

1) Extract files from an archive

2) Add, freshen, move, and updates files in an archive
3) Open an archive

Click on each of the above entries for more information.



Extracting Files from an Archive with the Drag and Drop Interface

Before using this portion of the Drag and Drop Interface, please note that it is not
documented by Microsoft. Thus, it is not guaranteed to work in future versions of Windows,
or even in all Windows 3.1 environments.

You can drag and drop files from WinZip to other applications. WinZip will extract the files
before dropping them on the target application. The target application will treat the files as
if they had been dropped by the File Manager.

To extract a file from an archive with the Drag and Drop Interface
1) Click on a file in the main WinZip window.

2) While holding down the mouse button, drag (move) the mouse pointer to a window that
accepts dropped files (the mouse pointer will indicate whether the target window accepts
dropped files).

3) Release the mouse button to drop the file. This activates the Extract dialog box. Once
the files have been extracted from the archive, the target window will process the file you
dropped.

Notes:

To extract multiple files from an archive using the Drag and Drop Interface, select the
desired files before beginning the drag operation.

You can also extract files by pressing the Extract push button or using the Extract entry on
the Actions pull-down menu.

You can move or copy files from one archive to another by opening multiple copies of
WinZip, one for each archive, and dragging files from one to the other.

Important:

Different applications handle dropped files in different ways. For example, when you drop a
file on the Write application distributed with Windows it will embed the file as an OLE object,
but when you drop a file on the Notepad application it will open the file. You may need to
experiment with drag and drop before relying on it.

The Windows File Manager will NOT accept files dropped by other applications. This is not a
bug, it is the result of a design decision made by Microsoft.

The Windows Program Manager adds dropped files to the group on which the files are
dropped. This provides a very convenient way to add files in an archive to a Program
Manager Group. Unfortunately, many people (particularly those who have used 0S/2 1.3)
would rather drop files on an icon in the Program Manager to start the program associated
with the icon, passing the dropped file as a parameter. However, there is nothing WinZip
can do about this. Again, this is not a bug, it is the result of a design decision made by
Microsoft.



Adding a File to an Archive with the Drag and Drop Interface

To add a file to an archive with the Drag and Drop Interface

1) Click on a file in the Windows 3.1 File Manager or an NDW 2.0 drive window.

2) While holding down the mouse button, drag (move) the mouse pointer to a WinZip
window. If you've minimized WinZip, you can drag the files to the minimized icon. If you're
using NDW 2.0, you can also drag files to inactive WinZip icons.

3) Release the mouse button to drop the file. This activates the Drop dialog box.

Notes:

To add multiple files to an archive using the Drag and Drop Interface, select the desired files
in the File Manager before dragging them to WinZip.

You can also add files to an archive using the Add dialog box.

You cannot use the Drag and Drop Interface to add files with an extension of ZIP, LZH, ARJ,
or ARC (use the Add dialog box instead).



Opening an Archive with the Drag and Drop Interface

To open an archive with the Drag and Drop Interface

1) Click on an archive in the Windows 3.1 File Manager or an NDW 2.0 drive window.

2) While holding down the mouse button, move (drag) the mouse pointer over a WinZip
window. If you've minimized WinZip, you can drag the files to the minimized icon. If you're
using NDW 2.0, you can also drag files to inactive WinZip icons.

3) Release the mouse button. This opens the selected archive.

Note: you can also open archives by double clicking on the name of an archive in the File

Manager, by clicking on the Open button in the main WinZip window, or by selecting Open
from the file pull-down menu.



Drop Dialog Box

The Drop dialog box is displayed when you use the Windows 3.1 or Norton Desktop for
Windows 2.0 Drag and Drop Interface to add files to an archive. When you click on the Add
button, the files you dropped are added to the open archive.

The Drop dialog box lets you change the name of the open archive in one of two ways:
1) Type the name of the archive in the Add to Archive edit field.

2) Click on the New... or Open... buttons to activate the standard New and Open dialog
boxes, respectively.

These shortcuts provide a quick way to add files to a different archive without going through
the File pull-down menu.

The Drop dialog box provides the following options:

- The Action drop down list provides four choices: Add, Freshen, Move, and Update.
These correspond to the PKZIP -a, -f, -mu, and -u options if you are working with a ZIP file.
They correspond to the LHA and ARJ a, f, m and u options when working with LZH and AR|
files, respectively.

- The Compression drop down list determines the compression method. This field is
disabled when working with LZH files.

- The Multiple Disk Spanning drop down list determines whether the archive can span
multiple floppy disks. See the section titled Multiple Disk Spanning for more information.

- The Recurse subdirectories check box corresponds to the PKZIP -r -p options, the LHA
/r1x1 option, and the ARJ -r option. It determines whether WinZip recursively traverses all
subdirectories underneath the specified directory when looking for files to add. This
provides an easy way to backup all files in a branch of a directory tree. The Recurse
subdirectories check box is disabled unless you drop a directory name on WinZip.

- The Save Full Directories check box corresponds to the PKZIP -P option. When working
with AR] files this check box prevents WinZip from specifying the e option. When this check
box is selected the full name of the file is stored in the archive, including all subdirectory
names. For example, it might cause the name "c:\myfiles\filename.ext" to be stored instead
of simply "filename.ext".

Note: To restore a branch of a directory tree added with the Recurse subdirectories
option, be sure to select the Use directory names check box in the Extract dialog box.




Menu Tree
File Menu

New Archive... - open a new archive

Open Archive... - open an existing archive
Close Archive - close the open archive
Select All - select all files in an archive
Deselect All - deselect all files in an archive
Exit - exit WinZip

Actions Menu

Add... - add files to the open archive

Delete... - delete files from the open archive

Extract... - extract files from the open archive

View... - view files in the open archive

Virus Scan - run a virus scan program against archive contents
Make .EXE File - create a self-extracting archive

Test - test integrity of an archive

CheckOut... - examine and/or run programs in an archive

Options Menu

Configuration... - modify configuration options

Directories... - specify default directories

Font... - specify font for main window

Password... - set password for subsequent archive operations

Program Locations... - specify program names and paths

Sort - specify sort order for list of files in archive

Save Settings on Exit - control whether options are saved when WinZip is closed
Save Settings Now - save configuration settings immediately

View Last Output... - view output from the last DOS command issued by WinZip

Help Menu

Contents - start Help and display topics in WinZip help file

Brief Tutorial - display brief WinZip tutorial

Search for Help on... - open search dialog box for WinZip help

How to Use Help - display instructions for using help system
Copyright/License Agreement/Warranty - display license agreement
Ordering Information - display order form

About WinZip ... - display copyright notice



The File Menu - Opening and Closing Archives

The following entries are available on the file menu:

- The New menu entry creates new archives (discussed below).

- The Open menu entry opens existing archives (discussed below).

- The Close menu entry closes the currently open archive. This menu entry is included
primarily for completeness, since the New and Open dialog boxes automatically perform this

action.

- The Select All and Deselect All menu entries select and deselect files in the main window's
list box. Selected files can be easily deleted, extracted, or viewed.

- The Exit menu entry exits (closes) WinZip.
Creating and Opening Archives:

To create a new archive use the New push button or the New entry in WinZip's File pull-down
menu. To open an existing archive use the Open push button or the Open entry in WinZip's
File pull-down menu. You can also open an archive listed in the File Manager by double
clicking on the archive (this starts a new instance of WinZip), or using the Windows 3.1 File
Manager Drag and Drop Interface.

Listing Self-Extracting Archives in the Open Dialog Box

To list self-extracting archives in the New and Open dialog boxes, select the entry that
includes EXE and COM files in the drop down list box titled "List Files of Type".

Note: When self-extracting archives are listed in the open dialog box, all EXE and COM files
in the selected directory will be listed, even if they are not self-extracting archives. WinZip
is not able to check whether a file is a self-extracting archive until it is opened.



Adding Files to an Archive
There are two ways to add files to an archive:

1) Use the Windows 3.1 File Manager Drag and Drop Interface, as described in the section
titled Drag and Drop Interface.

2) Click on the Add push button or select the Add entry from the Actions pull-down menu to
bring up the Add dialog box.

You can use the Add dialog box to choose the files added to an archive in two ways:

a) Type the name(s) of the files you want to add in the Add Files edit field and press the Add
button. Standard MS-DOS wildcards are accepted, and multiple file names can be specified.

b) Select files in the Select Files Extended Selection List Box and press the Add button. Use
the Update List button to update the list based on wildcards specified in the Add files edit
field.

The Add dialog box provides the following options:

- The Action drop down list provides four choices: Add, Freshen, Move, and Update.
These correspond to the PKZIP -a, -f, -mu, and -u options if you are working with a ZIP file.
They correspond to the LHA and ARJ a, f, m and u options when working with LZH and AR]
files, respectively.

- The Compression drop down list determines the compression method. This field is
disabled when working with LZH files. It is usually best to compress for size when creating
archives for BBS use, in order to minimize transmission costs. For faster operation,
compress for speed when archive size is not critical.

- The Multiple Disk Spanning drop down list determines whether the archive can span
multiple floppy disks. See the section titled Multiple Disk Spanning for more information.

- The Recurse Subdirectories check box corresponds to the PKZIP -r -p options, the LHA /r1x1
option, and the -r ARJ option. It determines whether WinZip recursively traverses all
subdirectories underneath the specified directory when looking for files to add. This
provides an easy way to backup all files in a branch of a directory tree.

- The Save Full Directories check box corresponds to the PKZIP -P option. When working
with AR] files this check box prevents WinZip from specifying the e option. When this check
box is selected the full name of the file is stored in the archive, including all subdirectory
names. For example, it might cause the name "c:\myfiles\filename.ext" to be stored instead
of simply "filename.ext".

Notes:

To restore a branch of a directory tree added with the Recurse Subdirectories option, be sure
to select the Use Directory Names check box in the Extract dialog box.

Use the Directories dialog box to determine the default directory for the Add dialog box.
You can change the directory by selecting from the standard drive and directory list boxes.



Deleting Files from an Archive
There are two ways to delete files from an archive:

1) Object-action interface: first select entries in the list box, then select the Delete entry
from the Actions pull-down menu.

2) Action-object interface: select the Delete entry from the Actions pull-down menu to bring
up the Delete dialog box. You can then specify the file names you want to delete (standard
MS-DOS wildcards are accepted). You can specify multiple file names, separated by spaces.

To delete an entire archive select the Delete entry from the Actions pull-down menu to bring
up the Delete dialog box. Then select the "Entire archive" radio button and click on the
Delete push button.



Extracting Files from an Archive

By default WinZip will automatically extract files from ZIP files without running PKUNZIP
when possible. See the section titled Built-in ZIP Extraction for more information on this
subject.

There are three ways to extract files from an archive:

1) Object-action interface: first select entries in the list box, then click on the Extract push
button or select the Extract entry from the Actions pull-down menu to bring up the Extract
dialog box.

2) Action-object interface: click on the Extract push button or select the Extract entry from
the Actions pull-down menu to bring up the Extract dialog box. You can then specify the file
names you want to extract (standard MS-DOS wildcards are accepted) or extract all files in
the archive.

3) With the Drag and Drop Interface.

The Extract dialog box lets you specify the directory to contain the extracted files. Use the
Directories dialog box to determine the default directory for the Extract dialog box.

Note: you can create a directory to hold the extracted files by simply typing in the name of
the directory in the To: field of the Extract dialog box and pressing the Extract button.

The Extract dialog box provides the following options:

- The "Overwrite existing files" check box. This option determines whether you are
prompted before existing files are overwritten with files in the archive. It corresponds to the
PKUNZIP -o option, the LHA /m1 option, and the ARJ -y option.

- The "Use directory names" check box. This option corresponds to the PKUNZIP -d -p
options, the LHA x option, and the AR] x option. When this option is checked WinZip
expands files to the path names stored in the archive. This option should be specified when
extracting files added with the "Recurse subdirectories" option in the Add dialog box.



Built-in ZIP Extraction

WinZip will extract files from ZIPs without running PKUNZIP if possible. You can switch to
other windows while the built-in ZIP extraction is running and can interrupt the extraction
process by pressing the Esc key. Built-in ZIP extraction generally saves time because there
is no need for WinZip to start PKUNZIP.EXE. However, on some machines (particularly on
slower systems) you may get faster turnaround by disabling built-in ZIP extraction. You can
disable built-in ZIP extraction by de-selecting the Use Internal Unzipping When Possible
checkbox in the Configuration dialog box.

Built-in ZIP extraction is not used in the following circumstances:

1) The ZIP contains files created by a version of PKZIP other than 1.1 or 2.0.

2) When running a DOS based virus scanner. In this situation it is usually faster to run
PKUNZIP than use built-in ZIP extraction.

3) If another copy of WinZip is currently in the process of unzipping files using built-in ZIP
extraction.

4) The ZIP contains password protected files.

5) The "Use Internal Unzipping When Possible" checkbox in the Configuration dialog box is
not selected.

6) You are running on an 80286 processor (built-in unzipping requires a 386 or better).
In these cases WinZip will automatically run PKUNZIP.

Note: WinZip always uses PKZIP.EXE to modify ZIP files.



Viewing Files in an Archive
Files can be viewed in several ways:

- with the View button in the toolbar or the View entry in the Action pull-down menu

- with the features described in the section titled CheckOut Facility

- most files can be viewed by double clicking on the file name in the main window's list box,
as described in the section titled Double Clicking

When you push the View button in the toolbar choose the View entry in the Action menu the
View dialog box is displayed. This dialog gives you a choice of viewing the selected file(s) in
one of three ways:

1) Using the Associated Program. This method is identical to double clicking on a file in the
main window except that executable files are not run, they are opened with the Default
Association defined in the Program Locations dialog box.

2) Using the Built-In ASCII Text Viewer. Multiple files can be viewed in on view operation
using this viewer.

3) With any viewer available on your system. You must specify the name of the viewer.

The Built-In ASCII Text Viewer is used view the results of the last DOS command issued by
WinZip.

Notes on the Built-In ASCII Text Viewer:

- Click on the Clipboard Copy push button to copy selected text to the system clipboard.
Note: this button is disabled when no text is selected.

- Unlike most dialog boxes, this dialog box can be resized and maximized.
- Due to limitations in the standard Windows multi-line edit control, the Built-In ASCII Text

View facility only displays the first 32K of a file. However, you can view larger files using
the methods described above.



Virus Scan

To use this feature a virus scanner must be configured, as described in the section titled
Virus Scanner Configuration.

The Virus Scan operation performs the following actions:

1) Creates a temporary directory

2) Extracts all files in the current ZIP to the temporary directory

3) Runs the virus scanner against files in the temporary directory

4) Deletes all files in the temporary directory and removes the temporary directory
5) Displays the results of the scan operation in the View window

Note: WinZip will not use Built-in ZIP Extraction when extracting files for use with a DOS
based virus scanner, as it would generally not improve performance.




Creating a Self-Extracting Archive

This operation converts an archive to a self-extracting archive. Self-extracting archives
have an extension of .EXE, and can be run as commands from the DOS prompt. When a
self-extracting archive is run, the files in the archive are automatically extracted. This is
convenient, because the PKUNZIP.EXE, LHA.EXE, or ARJ.EXE are not needed to extract files
from these self-extracting archives.

When working with a ZIP file, this operation runs the ZIP2EXE program. This program is part
of the PKZIP/PKUNZIP package from PKWARE, Inc. If ZIP2EXE.EXE is not in your path, you
can use the Program Locations dialog box to tell WinZip where to locate it.

When working with an LZH file, this operation runs the LHA program with the s option.

When working with an AR] file, this operation runs the AR] program with the y option.

You can use WinZip to add, delete, extract, view, and run files in a self-extracting archive the
same way you can manipulate a normal archive. Self-extracting archives are automatically

listed in the Open dialog box if the appropriate options are selected, as described in the
section titled The File Menu.



Testing an Archive

Use this feature to test the integrity of the open archive. This command runs PKUNZIP -t for
ZIP files, LHA t for LZH files, and AR] t for AR] files. A dialog box is displayed if any errors
are encountered. You can always use the View Last Output entry from the Options pull-
down menu to view the results of the command.



CheckOut Feature

The CheckOut feature makes it easy to examine and/or run files in an archive. It creates a
Program Manager Group containing one icon for each file in the archive. Double click on the
icon to run the file or to view the file with the program associated with the file (associations
are described in the section titled Windows Associations). WinZip will optionally delete the
Program Manager group and related files.

CheckOut Dialog Box
The CheckOut dialog box lets you configure these aspects of the operation:

1) You can specify the temporary CheckOut directory name. This directory will be created if
it does not already exist. Caution: any existing files in this directory will be replaced by files
in the archive.

2) You can specify the directory to contain the files in the archive. The suggested directory
depends on the setting of the CheckOut Base Directory in the Directories dialog box.

3) You can specify the maximum number of icons for the Program Manager CheckOut group.
The Windows Program Manager limits you to 50 entries, but you may prefer a lower number
to save time.

4) The Run Virus Scanner check box lets you specify whether WinZip will run a virus
scanner on the files in the archive. This option is disabled unless a virus scan utility is
installed in the Program Locations dialog box. WinZip will not use Built-in ZIP Extraction
when extracting files for use with a DOS based virus scanner, as it would generally not
improve performance.

Operations performed by the CheckOut feature:

When you click on the OK button in the CheckOut dialog box, WinZip performs the following
operations:

1) Deletes any existing files in the specified directory.

2) Extracts files in the current archive to the specified directory.

3) If the Run Virus Scanner check box is selected your virus scanner is run against all files
in the specified directory. If the virus scan utility returns a non-zero error level, the

CheckOut operation is aborted and messages from the scanner are displayed.

4) Deletes the specified Program Manager group if it exists. This ensures that the group will
only contain entries for the files in the current archive.

5) Creates a new Program Manager group containing one icon for each file in the archive.
Using the Program Manager group created by CheckOut:

The Program Manager group created by CheckOut works like all other Program Manager
Groups. WinZip sets up this Group with icons for each file so that you can use them as

follows:

1) If a file is executable, double clicking on the icon runs the program.



2) If a file has an association, double clicking on the icon loads the file in the associated
program so you can view the file.

3) Otherwise, double clicking on the icon loads the file in the WinZip "Default association"
program specified in the Program Locations dialog box. The default for the "Default
association" program is the Windows Notepad utility, but this can be changed from the
Program Locations dialog box.




Options

The Configuration Dialog Box lets you specify miscellaneous WinZip configuration
information, including the default archive format and the action performed when you double
click on files in the main WinZip window.

The Directories Dialog Box lets you specify the initial WinZip working directory, the default
Extract directory, and an optional temporary directory for use while creating archives.

The standard Font dialog box lets you specify which font is used for the list of files in an
archive.

The Password Dialog Box lets you set a password for the open archive.

The Program Locations Dialog Box lets you specify the location of external programs,
including PKZIP and your default file viewer.

The Sort by entries in the Options pull-down menu let you specify whether the list of files in
the archive is sorted by name, path, type, size, compression ratio, compressed size, date, or
whether the original archive order should be used. You can also change the sort order by
clicking on the appropriate portion of the main listbox header. For example, click on the
word Date in the header to sort by date.

The Save Settings on Exit entry in the Options pull-down menu determines whether
options are automatically saved when WinZip is closed. The Save Settings Now entry in
the options pull-down menu saves the options immediately. Options that are saved and
restored include all the options in the "Options" pull-down menu, all options in the Add,
Configuration, and Extract dialog boxes, and the current screen size and location. The
options in the Directories Dialog Box and the Program Locations Dialog Box are saved
regardless of the whether Save Settings on Exit is checked.

The View Last Output... dialog box displays the results of the last external command
issued by WinZip.



Configuration Dialog Box
The Configuration dialog box lets you specify
- Whether the normal prompt dialog boxes are displayed in the following circumstances:

- When a file is dropped on WinZip. If no prompt is displayed, the file is automatically
added to the open archive using the options last specified in the Drop dialog box. Note
that when an archive is dropped on WinZip the archive is opened regardless of this
setting.

- When a file is dragged from WinZip to another application. If no prompt is displayed,
the file is automatically extracted using the options last specified in the Extract dialog
box.

- When the View button is pushed. The selected file(s) are automatically viewed. Note
that when View is selected from the Action pull-down menu this setting is ignored.

- When the Extract button is pushed. The selected file(s) are automatically extracted
using the options last specified in the Extract dialog box. Note that when Extract is
selected from the Action pull-down menu this setting is ignored.

- The Default Archive Format. This format is used when you specify the name of an archive
without an extension while creating or opening an archive, and when creating an archive
with an extension other than .ZIP, .LZH, or .ARJ. If you select "None", WinZip will prompt
you for the archive format in these situations.

- Whether WinZip should automatically show the Open dialog box when you start WinZip.

- Whether WinZip should try to use Built-in ZIP Extraction when possible, instead of running
PKUNZIP.

- Whether WinZip should have the always on top attribute, so that it is not overlaid by
normal windows.

- Whether WinZip should enable/disable PKZIP 2.0's use of DPMI, EMS, and XMS, and
whether the PKZIP "slow memcopy" switch should be used. PKWARE recommends that
DPMI and XMS be disabled under Windows. See your PKWARE documentation for details on
these settings.

- Whether WinZip should maintain a log of all error messages and all external commands it
issues. Examples of external commands are PKZIP, LHA, and ARJ. You can specify the drive
used for the log file. The log is written to the file WINZIP.LOG in the root directory of the
selected drive.

- Whether WinZip should list the files in the archive in lowercase for improved legibility.

- Whether WinZip should beep after archive operations complete.

- Whether WinZip displays large push buttons. The default for this setting depends on your
video setup.

- Whether compressed file sizes and the compression ratio should be displayed in the main
WinZip listbox.



Directories

The Directories dialog box lets you specify the following information:

Start-up Directory

Unless you start WinZip by double clicking on an archive, WinZip will optionally change to a
directory of your choice when it starts up. Files in this directory are automatically displayed

in the Open and New dialog boxes. The following choices control which directory is used.

- System default - WinZip does not change directories, so the system default directory will
be in effect. Usually this will be the directory containing WINZIP.EXE.

- Last Open Archive - WinZip will change to the directory containing the last open archive
during your last WinZip session.

- Directory: - WinZip will always change to the specified directory.
Default Extract Directory
These selections determine the default directory WinZip automatically inserts into the

"Extract To" field in the Extract dialog box. You can, of course, type over this default
directory name or select a different directory from the directory listbox.

- Open Archive Directory - WinZip will insert the name of the directory containing the
open archive into the "Extract To" field. For example, if the archive c:\download\tools.zip is
open, WinZip will insert c:\download.

- Last Extract Directory - WinZip will insert the name of the directory you used during the
last Extract operation. This value is saved when you exit WinZip so you can use it during
your next WinZip session.

- Directory: - WinZip will always insert the specified directory. This value is saved when
you exit WinZip so you can use it during your next WinZip session.

Default Add Directory
These selections determine the default directory when the Add dialog is opened.
- Open Archive Directory - WinZip will use directory containing the open archive.

- Last Add Directory - WinZip will use the directory you used during the last Add operation.
This value is saved when you exit WinZip so you can use it during your next WinZip session.

- Directory: - WinZip will always use the specified directory. This value is saved when you
exit WinZip so you can use it during your next WinZip session.

Optional Working Directory

If specified, WinZip passes this directory name to PKZIP via the -b switch and to ARJ via the -
w switch. This can be useful when updating an archive when there is not enough room on
the destination drive for both the original archive and the updated archive. This option
causes PKZIP and AR] to create the updated archive in the temporary directory, delete the
original, and finally copy the updated archive to the destination drive.



CheckOut Base Directory

If specified, WinZip uses this directory as the prefix for the default directory in the CheckOut
dialog box. If this field is left blank WinZip will instead use the directory containing the open
archive.



Password Protection

Files in ZIP and ARJ archives can be password protected by specifying a password in the
Password dialog box. To access this dialog box use the Password entry on the Option pull-
down menu.

If a password is specified then the password will be used to encrypt and decrypt files
subsequently added or extracted from the archive. This feature can be useful to protect
data when storing archives with sensitive information in unsecured places.

If a password is active the Add dialog box title will indicate that files will be password
protected. The main WinZip window lists password protected files with a plus sign following
the filename.

Notes:

Passwords are cleared (reset so that no password is used) when an archive is closed or
another archive is opened.

If a ZIP file contains password protected files, PKUNZIP is always used to extract files.

Be sure to remember any passwords you use! If you forget a password then files protected
by the password cannot be recovered!



Program Locations

The Program Locations dialog box lets you to specify the paths and filenames for the
external programs used by WinZip. These programs are not distributed with WinZip. For
more information on these programs, including availability and minimum version numbers,
see the section titled System Requirements.

When WinZip is installed it will attempt to locate the default programs in the directories
specified in your PATH= environment variable. If it cannot find these programs, it will leave
the corresponding edit fields blank.

If a program is not installed on your system, just leave the corresponding edit field blank.
Otherwise, fill in the program name. The extension defaults to EXE. If no path is included
for an entry, WinZip assumes the program is in a directory specified in your PATH=
environment variable.

See the section titled Virus Scanner Configuration for information about that portion of the
Configuration dialog box.

Default association
The program specified as the Default Association is run in two situations:

1) When you double click on a file in the main WinZip window and the selected file does not
have WIN.INI association.

2) When the View action is chosen and the View Action Runs External Viewer checkbox is
selected in the Configuration dialog box.

The default values for this field are:

- NVIEWER.EXE, the Norton Desktop for Windows File Viewer, if is found in a directory
specified by your PATH= environment variable.

- WNFV.EXE, the PC Tools for Windows File Viewer, if it is found in a directory specified by
your PATH= environment variable.

- NOTEPAD.EXE, the Windows Notepad program, if NVIEWER.EXE is not found.

Any other file viewer or editor can be used. For additional information on associations, see
the section titled Windows Associations.



Virus Scanner Configuration

WinZip supports most virus scanners that can be run from the DOS command line, with a
few important limitations noted below.

If one of the following programs is in a directory specified by your PATH= environment
variable when WinZip is first installed, WinZip will automatically detect it and fill in the
Location dialog box with the appropriate options:

Scanner Parameters
SCAN.EXE /A /nomem *.*
NAV.EXE **/m- /s

CPAV.EXE ** [P
MSAV.EXE *xP

Do not use WinZip's virus scanning support with a different virus scanner unless you have
read and understood the information below!

To configure WinZip for a virus scanner, fill in the following fields in the Program Locations
dialog box:

1) The program name (the full path name is required if the program is not in a directory
specified in your PATH= environment variable).

2) The parameters to run the virus scanner. The rules for virus scanner parameters are:

a) Use ** to indicate where WinZip should substitute the drive and directory of the
files that are to be scanned.

b) If you do not specify *.*, or do not specify any parameters, WinZip will append the
filenames to be scanned at the end of the scanner command line.

Be sure to check your virus scanner documentation for important parameters. For example,
the McAfee SCAN program normally only checks .EXE and .COM files for viruses, so the /A
parameter is specified for additional protection.

3) The "Run as iconized DOS session if possible" check box determines whether WinZip will
run the virus scanner as an icon if you are running Windows in Enhanced Mode. (Note: in
Windows Standard mode DOS applications can only be run in full-screen mode.) Do not
select this check box unless you are running one of the scanners listed above, or are sure
you understand the following information!

The "Run as iconized DOS session if possible" check box should only be used under the
following circumstances:

a) The scanner is configured to run in "batch" mode, without any prompts. If the
scanner requires any keyboard input when running as an icon, you will not be able to
see the prompts, and the session will appear to be hung.

b) The scanner writes all messages through DOS. Messages written directly to the
video buffer are not captured by WinZip and will be lost. To determine whether a
scanner writes messages through DOS, run the scanner with its output redirected (for
example, issue the command "scan > nul"). Any messages you see during this test
will not be captured by WinZip.



c) The scanner returns a non-zero error level if it encounters any problems. |If the
scanner does not return a non-zero error level, WinZip will assume the files passed
the virus check, and any warnings issued by the scanner will be lost. (Note: if the
scanner returns a non-zero error level, WinZip automatically displays all messages
written to standard error or standard output.)



Enhanced and Standard Modes

In Windows 386 Enhanced mode PKZIP, PKUNZIP, LHA, and other programs run by WinZip
are executed in the background in an iconized DOS session. While these commands are
running you can switch to another window using the Task Manager or by clicking on the
desired window. An hourglass pointer is used to indicate that the WinZip window is busy.
You can double click on the icon titled "WinZip running DOS commands" to monitor the
command's progress. If any of these commands prompts the user for input, WinZip will
automatically bring the DOS session to the foreground.

Unfortunately, Windows does not allow you to execute these commands in the background
under Standard mode. In Standard mode your screen will be cleared, and these commands
will be run in a full screen DOS session.

In all cases you can view the messages displayed by the last command issued by
WinZip by selecting View Last Output in the Options pull-down menu.

Your Windows User's Guide contains descriptions of Enhanced and Standard modes. You
can determine which mode is active by choosing the About entry in the Program Manager's
Help pull-down menu.



Using Extended Selection List Boxes

WinZip uses Extended Selection List Boxes for the list of files in the open archive and for the
list of files in the Add dialog box. You can select files from an Extended Selection List Box
the same way as you select files in the File Manager.

To select an individual file in an Extended Selection List Box, click on the file. This cancels
all previous selections. To select two or more files in sequence click on the first file, then
press and hold down the Shift key while you click on the last file in the group. To select two
or more items out of sequence press and hold down the Ctrl key while you click on each file.

In addition to the aforementioned standard methods for working with Extended Selection
List Boxes, you can use the right mouse button to select files without canceling previous
selections. This feature was added for compatibility with Norton Desktop for Windows.

You can use the "Select All" and "Deselect All" entries in the File pull-down menu to select
and deselect all files in an archive. Note that "Deselect All" leaves the current entry
selected. This is the way extended selection list boxes work, and is not specific to WinZip.

The keyboard interface for Extended Selection List Boxes is described in the section titled
Keyboard Usage.



Double Clicking

Double clicking on a filename listed in the main WinZip window will perform the same action
as when you double click on a file in the File Manager. If the file is executable (has a
filename extension of EXE, COM, BAT, or PIF) WinZip will run it. Otherwise WinZip will open
the file with the appropriate application. For example, files with a filename extension

of .WRI are opened by the Windows Write application. The appropriate application is
determined via Windows Associations. If no application is associated with the file, WinZip
will run the program specified as the default association in the Program Locations dialog box.
If you modify the file, WinZip will offer to add the modified file to the archive.

Note: Pressing the Enter key performs the same action as double clicking.



Windows Associations
Microsoft has defined the word "associate" as follows:

To identify a filename extension as belonging to a certain application, so that when you
open any file with that extension, the correct application is opened automatically.

For example, by default, Windows associates .WRI files with the WRITE application, and .CRD
files with the CARDFILE application. Most Windows application installation procedures
create associations. For example, Word for Windows creates an association for .DOC files,
while WinZip creates associations for files with the extensions .ZIP, .LZH, .ARJ, and .ARC.

WinZip uses associations when you Double Click on a filename listed in the main WinZip
window and when you use the CheckOut Feature.

WinZip, the Program Manager, and the File Manager all use associations the same way.
When you double click on a file with an association, the application associated with the file is
run, and the application automatically opens the file. The WinZip CheckOut facility
establishes associations when it updates the Program Manager CheckOut group for two
reasons: to display the right icon for each file, and to ensure that the appropriate application
is run when you double click on an icon.

You can view or add associations using the Associate entry in the File Manager's File pull-
down menu as follows: start the File Manager and select a filename with the extension you
are interested in. Then choose the Associate entry in the File Manager's File pull-down
menu. The File Manager will display the Associate dialog box showing the currently
associated program. To change the association type the program name in the edit field and
choose OK.

Note: For more information on associations press the F1 key or Help button while the File
Managers Associate dialog box is displayed.



Multiple Disk Spanning

Multiple Disk Spanning allows archives to span multiple floppy disks. This feature is useful
when the data being archived does not fit on one floppy disk. It is available via the Add and
the Drop dialog boxes. This feature is disabled for LZH files, and is disabled if the open
archive is not on removable media. Note the following restrictions:

ZIP files:

PKZIP 2.0 or later is required. Any files in the open archive will be replaced (a confirmation
dialog is displayed before data is replaced). If any of the destructive spanning options (e.g.
format or wipe disk) are specified, all data currently on the disk will be lost. For details on
the options, see the Backup Guide in your PKZIP documentation.

AR] files:

WinZip automatically provides non-destructive disk spanning for ARJ files on removable
media by using the -vva option for add, move, freshen, and update operations.



Error Handling

WinZip does not modify archives directly. Instead it runs external commands like PKZIP,
LHA, and ARJ for all operations that update archives. Thus, it is highly unlikely that WinZip
will ever cause a corrupted archive.

If you suspect a corrupted archive, you can test it with the Test entry in the Actions pull-
down menu.

When an external command issued by WinZip returns a non-zero error level, a dialog box is
displayed listing the error level and, if possible, an error description. Click on the "View last
output" button to view all messages issued by the command that caused the error.

WinZip will optionally maintain a log of all error messages and all external commands (for
example, PKZIP and LHA) it issues. The log is written to the file WINZIP.LOG on the drive
selected in the Configuration dialog box.



Keyboard Usage

WinZip is easier to use with a mouse, but you can also use the standard Windows keyboard
interface. Keyboard accelerators defined for WinZip include:

Ctrl+N Open a new archive.

Ctrl+0 Open an existing archive.

Ctrl+A Add files to an archive.

Ctrl+D Delete files from an archive.

Ctrl+E Extract files from an archive.

Ctrl+V View files in an archive.

Ctrl+C Activate CheckOut feature.

Ctrl+S Run virus scanner.

Ctrl+T Test archive.

Ctrl+M Run ZIP2EXE, LHA, or ARJ to create a self-extracting archive.

Ctrl+Slash (/) Select all items in the list box.

Ctri+Backslash (\) Cancel the selection of all items in the list box.

Direction key(s) Move the cursor or scroll to other items in the list box.

Shift+direction keys Select multiple items in list box.

Enter Same as Double Clicking in the main window listbox.

Shift+F8 Toggle "add mode" on and off. When add mode is on, the selection cursor blinks.
In this mode you can use the Spacebar to select non consecutive items in the list box or to

cancel the selections. Press Shift+F8 again to end add mode. Clicking the left mouse
button cancels any selections.



Ideas for Future Enhancements

Ideas for future enhancements include:

- Support for other archive file formats, including PAK and ZOO. (Let me know which are
most important to you!)

- Built-in ARJ and LZH file extraction

- Support for all ZIP, LZH, and ARJ options, including comments, volume labels, and
authenticity verification (AV number support)

- Support for printing, using the appropriate application to print, depending on the file
- Basic file management (for example, copy and move the open archive)
- User configurable toolbar

Additional suggestions from all users are welcome!



Hints and Tips
Here are a couple hints and tips you may find useful:

1) Use the File Manager to select archives you want to open. Unlike the Open dialog box,
the File Manager lets you sort archives (and other files) by date and size. Either double click
on the archive you want to open or use the Drag and Drop Interface to drop an archive from
the File Manager onto WinZip.

2) Use the Drag and Drop Interface to add files to archives. The main advantage to using
the Drag and Drop interface over the Add Dialog Box is that you can sort files by date and
size.

3) If you usually download files to the same directory, specify that directory as the Start-up
Directory in the Directories dialog box, so that WinZip starts up in that directory. To save
yourself the time and trouble of clicking on the Open button or selecting Open from the File
pull-down menu, check the "Automatically Show Open Dialog Box" button, also in the
Configuration dialog box. Be sure the "Save Settings on Exit" entry in the Options pull-down
menu is selected before closing WinZip.

4) To select multiple discontiguous files in the main WinZip list box, see the section titled
Using Extended Selection List Boxes.

5) To switch to another program while WinZip is executing a DOS command, click on the
window for the other program, or bring up the Task Manager by double clicking over the
desktop or pressing Ctrl+Esc. Note: you can't use the WinZip system menu or minimize
button while WinZip is executing a DOS command.

6) To start WinZip automatically when you start Windows, copy the WinZip icon to your
Startup Group. Optionally select the Run Minimized checkbox to start WinZip as an icon.
See your Windows manual for information on copying icons and creating Groups.

7) You can change the default WinZip icon as follows:

a) Open the Program Manager group window for the group containing WinZip.
Highlight the WinZip icon.

b) Choose Properties from the File menu, press Alt+Enter, or press Alt while double
clicking the icon. The Program Item Properties dialog box appears.

¢) Click on Change Icon.
d) Double click on your preferred icon.
e) Choose OK.

8) To change the default WinZip window size and position to the current window size and
position, be sure the "Save Settings on Exit" entry in the Options pull-down menu is selected
before closing WinZip.

9) If you run out of space in the directory specified by your TMP= or TEMP= directory when
using the Scan feature, add the following command to your AUTOEXEC.BAT file:

SET WZTMP=d:\dir
where d:\dir specifies a drive and directory with more free space than your TMP= or TEMP=
directory. Note that you'll have to reboot your machine for this change to take affect.



10) If you have a large RAM disk, use it as a temp directory to significantly speed up many
archive operations (see hint 7 above).

11) You can move or copy files from one archive to another by opening multiple copies of
WinZip, one for each archive, and dragging files from one to the other.

12) If your preferred font is the one used by WinZip 3.1, select the "Fixedsys" font in the Font
dialog box.



Notes and Background Information

- WinZip supports most commonly used PKZIP and PKUNZIP options but, the current version
does not include support for comments, volume labels, and file attribute masks. Support
for these and other features is planned for future versions.

- WinZip uses temporary disk files to communicate with WZ.COM and the PKWARE, Inc.
programs. WinZip uses unique filenames for these files, and automatically erases them
when they are no longer needed. WinZip determines which disk to use by checking the
value of the WZTMP=, TMP=, TEMP=, and PKTMP= environment variables. To conserve
space on the DOS command line, WinZip creates temporary files in the root directory of the
specified drive. If none of these environment variables is set WinZip uses the root directory
of your C: drive.

- The original release of Norton Desktop for Windows 2.0 will crash if you drop too many files
on an inactive application icon (for example, WinZip). For example, if you select all the files
in your Windows directory and drop them onto an icon for the Windows Notepad program,
NDW will get a protection exception. There is nothing WinZip can do about this problem.

- WZ.COM is used for two reasons: to obtain the error level (return code) from the PKZIP and
PKUNZIP commands, and to capture the output from these commands for use by the "View
Last Output" entry in the Options pull-down menu.

- WinZip is a Windows version of PMZIP, my Shareware ZIP shell for the OS/2 Presentation
Manager. | wrote PMZIP because | wanted a PM interface to ZIP files, and no other programs
provided this facility. The first version was written in Digitalk's Smalltalk V/PM. The result,
like all V/PM programs, required over a megabyte of code to execute, and was rather slow.
Favorable response to the first version convinced me to rewrite the program in C and release
it as Shareware. |subsequently rewrote it for Windows, and this is the result.
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Version History
The following changes were make in WinZip 4.1

- The View Dialog Box can now be used to run the program associated with the selected file,
the internal viewer, or any external viewer.

- Added an all-new and easier-to-use Add Dialog Box.

- The CheckOut Dialog Box now lets you create permanent Groups.

- Added Password support.

- Added a status line and header. The status line includes green and red lights to show
when WinZip is ready/busy and a meter to show progress of internal unzipping.

- Added support for creation of ZIPs that span multiple floppies.

- Support for all PKZIP 2.0 compression methods.

- Added more sort fields (you can click on titles in the header to sort).

- Rearranged Options menu.

- The compressed file size and compression ratio are optionally displayed.

- Added optional "always on top" checkbox in Configuration dialog box.

- Multiple WinZip windows no longer overlay each other.

- Some prompts can be suppressed from the Configuration dialog box. Alternately, these
prompts can also be suppressed by pressing the shift key. For example, hold down the shift
key will dropping a file to avoid the Drop dialog box.

- Removed Windows 3.0 support.

The following changes were made in WinZip 4.0b:

- Fixed one bug that only occurred on 80286 machines.

The following changes were made in WinZip 4.0a:

- Built-in ZIP extraction is much faster. An 80386 based system or better is now required for
built-in ZIP extraction.

- Added support for the Central Point CPAV virus scanner.

- Fixed a couple bugs, including one that prevented using ARC files in some configurations,
and a problem extracting from ZIPs that span multiple floppies.

The following changes were made in WinZip 4.0:

- Added PKZIP 2.0 support.



- Added support for the AR] file format.

- Added a new toolbar with descriptive pictorial push buttons (WinZip chooses the button
size based on your video setup - you can alter the default via the Configuration dialog box).

- Added 3-D look to dialog boxes.

- Added the Directories dialog box.

- Added an optional beep after archive operations complete.
- Added support for the Norton Anti-Virus program (NAV.EXE).

- Added the last few archives opened to the File pull-down menu for easy access.

The following changes were made in WinZip 3.2:

- Added Built-in ZIP Extraction so that PKUNZIP is not needed for most ZIP extract
operations. WinZip always uses PKZIP.EXE to modify ZIP files.

- Added font selection for the list of files in an archive. By default WinZip uses the font you
specified in the Windows File Manager.

- Added an "Overwrite existing files" check box to the Extract dialog box to prevent
accidentally overwriting existing files.

- If a DOS command (for example, PKUNZIP or SCAN) running as an icon prompts for user
input, WinZip will automatically bring the DOS session to the foreground.

- If you modify a file after double clicking on it, WinZip will offer to update the archive with
the modified file.

- WinZip now uses the file WINZIP.INI instead of WIN.INI to save options. WIN.INI is only
used for the WinZip version number, to help prevent accidental sharing of WINZIP.INI files.

- Added the "Optional ZIP temporary directory" entry to the Configuration dialog box (moved
to the Directories dialog in WinZip 4.0).

Minor changes/fixes:
- WinZip changes its title bar while it is running DOS commands.
- Longer pathnames are allowed in the Configuration and Program Locations dialog boxes.

- The size of the "normal" WinZip window is now saved if you close WinZip while it is
iconized.

- Minor bug fixes.
The following changes were made in WinZip 3.1b:

- Added ability to drag and drop files from WinZip to other applications. WinZip will extract
the files before dropping them on the target application. The target application will treat
the files as if they had been dropped by the File Manager.



- Added a new error message for the unsupported NAV and NAVW virus scanners.

- Added a registration database check if no association is found when the user double clicks
on a file or uses the CheckOut feature.

- Fixed a bug that prevented WinZip from opening ZIP files with very long ZIP comments.
The following changes were made in WinZip 3.1a:

- Increased the background priority in the WZ.PIF file. This change can make long running
ZIP/UNZIP operations run twice as fast.

- The right mouse button now works the same way as in the Norton Desktop for Windows File
Manager. You can use it to select non-adjacent entries in the main WinZip listbox. Note
that holding down the Ctrl key while pressing the left mouse button performs the same
function.

- You can save WinZip settings without exiting WinZip by holding down the shift key while
double clicking on the system menu or while selecting File/Close. This was done by request
for additional compatibility with the Windows 3.1 File Manager and Program Manager.

- The Drag and Drop dialog box edit field is pre-loaded with the current directory if there is
no open archive.

Minor bug fixes:

- The Enter key now always performs the same function as the OK push button in the New
dialog box.

- An unnecessary error message is no longer issued when opening an existing ARC file with
the New dialog box.

- If WinZip is closed while it is iconized, it will also be iconized the next time it is started.
- A more descriptive error message is issued when WinZip is run under 0S/2 2.0.

- Toolbar push buttons are slightly larger on displays with a small system font.

The following changes were made in WinZip 3.1:

- Added support for Windows 3.1 Drag and Drop Interface.

- Added support for Norton Desktop for Windows 2.0 Drag and Drop Interface.

- Enhanced Extract dialog box with common dialog directory and drive list.

- Added check box to automatically open the Add dialog when creating a new archive.
- Added Test action for ZIP and LZH files.

- Changed pull-down menu choices for Windows 3.1 compatibility:
- Cosmetic changes (for example, capitalization)
- Changed Sort by extension to Sort by Type
- Added Help/Search menu entry



- Deleted Help/Help for keys

- Replaced Options/Defaults dialog with Save Settings on Exit menu entry for compatibility
with the Windows 3.1 File Manager and Program Manager.

- Added ability to specify drive for the optional log file in Option/Configuration dialog box.

- Added "Save path information" check box to Add dialog box.

- Switched to an 8 point font in dialog boxes for consistency with Windows 3.1 applets.

- Added file types ZIP, LZH, and ARC to New and Open dialog boxes.

- The default directory for Extract operations is now "sticky". In earlier versions of WinZip
the default was always the directory containing the archive. If you prefer the old behavior,
select the "Current directory" radio button in the "Extract to" group in the Configuration

dialog box.

- Dates are displayed in mm/dd/yy or dd/mm/yy format depending on the system date
format.

- Fixed a couple bugs.

The following changes were made in WinZip 3.0:

- Added LZH file support, including self-extracting (SFX) LZH files.

- Added configurable virus scanning (support for most command line virus scanners).
- Added optional support for Microsoft Common Dialogs if COMMDLG.DLL is installed.
- Added support for Norton Desktop for Windows.

- Made improvements to many dialog boxes.

- Simplified interface for archiving files in a subdirectory tree.

- Fixed a couple bugs.
The following changes were made in WinZip 2.00:

- Double Clicking on a file now has the same effect as double clicking in the File Manager.
This behavior can be altered with a Configuration option.

- Added CheckOut facility.

- Added support for ARC Files.
- Added optional interface to Virus Scan software.
- Added support for self-extracting ZIP files (ZIP2EXE).

- Added Program Locations dialog box.




- Added option to delete an entire ZIP in the Delete dialog box.

- Added separate sorted list boxes for filenames and directories in the Open dialog box.
- Added list box containing directories in the New dialog box.

- Added a "Default current directory" configuration option (see the first item in the Hints and
Tips section for a description of why this can be useful).

- Added keyboard mnemonics for controls in all dialog boxes.

- Moved push buttons to a button bar on top of the main window, and added the New, Open,
and CheckOut buttons.

- Temporary files are cleaned up sooner.
The following changes were made in WinZip version 1.00a:

- Fixed bugs which caused errors accessing WinZip temporary files under certain
circumstances.

- Check for maximum command line length of 127 (instead of 128).
- Double clicks on WinZip windows are ignored while PKZIP is running.

- Reworded text in File/New dialog box.



To create self-extracting archives, first create a standard ZIP or LZH file, then use the

Make .EXE File menu entries in the Actions pull-down menu. While both PKZIP and LHA let
you create archives with an extension of .EXE, these .EXE files are not self-extracting
archives, and attempting to run them can lock up your system.



Select the archive format for the archive you are creating or opening. This dialog box is
only displayed if you have selected "none" as the Default Archive Format in the

Configuration dialog box.



Missing File(s)
A required file was not found.

The file listed in the dialog box was not found in your path or the specified location. Also,
WINZIP.HLP, WZ.DLL, WZ.COM, and WZ.PIF must both be in the same directory as
WINZIP.EXE. The Installation section describes the complete installation procedure.



Invalid Archive

This dialog box is displayed if WinZip was unable to open the specified archive, read the
archive directory, or if a filename is invalid. It is possible that the file is not an archive.
Alternately, it is possible that the archive has been corrupted. If you are working with a
ZIP file, try running the PKZIPFIX program distributed with PKZIP to fix the
archive. For more information, see the section titled Error Handling. Other reasons for
this error include insufficient memory and disk errors while reading the archive.




Add Files Selected in List Box?

This dialog box is displayed if you've updated the edit field in the expanded Add dialog box
after selecting files from the list box. WinZip isn't sure whether you want to add the

selected files or add the files that match the names specified in the text field. To add the
selected files click on the OK button.



Register WinZip

Please enter your name and registration number exactly as they appeared on the mailing
label of your WinZip order or upgrade notification. If entered correctly, your name will
appear in the About dialog box, and the registration reminder dialog box will no longer be
displayed when you start WinZip. Please save this information for possible use with future
upgrades, or in case you re-install WinZip.

Note: If your name is spelled incorrectly in the upgrade notification, please write to the
address in the About dialog box with the correct spelling, and you will receive a new
registration number.



This dialog box is displayed when an unexpected WinZip internal error occurs. Please
contact the author with as much information about the error as possible. For a list of
contact points, choose About from WinZip's Help pull-down menu.



This dialog box is displayed when a required edit field is empty or no entries are selected in
a list box. For example, it is displayed if you don't specify which file you want to open in the
Open dialog box. Specify the required information and try again.



This dialog box is displayed if you click on the Add button in the expanded Add dialog box
but haven't selected any files to add. Select one or more files in the file list box, or click on
the Cancel button.



To view a file, WinZip normally extracts the file to disk, reads it, and erases the temporary
disk file. WinZip determines which disk to extract to by checking the value of the WZTMP=,
TMP=, TEMP=, and PKTMP= environment variables. To conserve space on the DOS
command line, WinZip creates temporary files in the root directory of the specified drive. If
none of these environment variables is set, WinZip extracts to the root directory of your C:
drive.

The message The disk file "filename" already exists. Should WinZip overwrite it so that the
file in the ZIP can be viewed? is issued if a file with the requested name already exists on
disk. If you choose Yes, the existing disk file will be overwritten, and processing will
continue. If you select No, WinZip will abort the view operation for this file.



This dialog box is displayed if WinZip cannot display the entire file you are viewing because
it contains binary zeros. WinZip uses a standard multi-line edit field to display files, and
these controls truncate text at the first binary zero.



This dialog box is displayed if you try to open a ZIP with a directory too large for WinZip to
handle. You will not be able to open the ZIP file with this version of WinZip.



This dialog box is displayed if an external command (for example, PKZIP or PKUNZIP) is
over 127 characters long (the longest command allowed under MS-DOS is 127 characters).
The total command line length includes several components used internally by WinZip in
addition to the external command. There are a couple ways to reduce the length of the
command line:

1) Move WINZIP.EXE (and the related files) to a directory near the root directory (for
example, a directory like C:\WINZIP is better than C:\WINDOWS\UTILITY\SHAREWAR\WINZIP).

2) Move the archive you are working with to a directory near the root directory.

3) Move PKZIP.EXE, PKUNZIP.EXE, LHA.EXE, SCAN.EXE, etc. to a directory specified by your
PATH= environment variable and remove any directory names for these programs in the
Configuration dialog box.

3) If you are adding, deleting, extracting, or viewing multiple files at one time, specify them
via a list box rather than an edit field. This causes WinZip to create a PKZIP/PKUNZIP, LHA,
or ARJ response file, which usually takes less room on the command line than multiple file
names.



Selected Text Successfully Copied To Clipboard

This dialog is displayed to let you know the text selected in the View dialog box has been
copied to the system clipboard. You can paste the text into another application (for
example, Notepad) by choosing Paste from the application's Edit pull-down menu.



This dialog box is displayed when WinZip could not create a required temporary file on the

disk drive listed in the dialog box. Possible causes are that the disk drive is invalid, or that
the root directory of the disk is full.

WinZip determines which disk to use for temporary files by checking the values of the
WZTMP=, TMP=, TEMP=, and PKTMP= environment variables. To conserve space on the
DOS command line, WinZip creates temporary files in the root directory of the specified

drive. If none of these environment variables is set, WinZip creates temporary files on your
C: drive.



The program required to perform the function you selected is either not installed, or is
installed in a directory other than the one specified in the Program Locations dialog box.

For example, to extract files from an ARC file, you need to have specified an ARC extraction
program, and the ARC extraction program you specified must exist..



WinZip can't find one of the programs specified in the active dialog box. If you specified a
directory (for example, you entered C:\UTILITY\PKZIP.EXE), then WinZip can't find the
program in that directory. If you did not specify a directory (for example, you entered

PKZIP.EXE) then WinZip can't find the program in any of the directories specified by your
PATH= environment variable.

Note: if you update your PATH= statement, the changes will not take effect until you reboot
your machine.



WinZip does not recognize the name of the specified program. For example, you will get
this error if you specify UNZIP.EXE as the name for PKUNZIP.EXE. WinZip lets you specify
the drive and directory containing the program, but prevents the use of unsupported file

names to prevent unexpected errors.



Your ARC extraction program returned a non-zero error level. Consult the documentation for
your ARC extraction program for the meaning of the error, and/or use the View Last Output

entry in the Options pull-down menu to check for error messages issued by the ARC
extraction program.

Note: one likely cause for this error is using an old version of the ARC extraction program.
See the section titled System Reguirements section of the documentation for version
information.




This dialog box is displayed to give you a chance to confirm that you really want to delete
the entire archive. Select No to abort the operation or Yes to delete the archive.



This dialog box is displayed to give you a chance to have WinZip delete the temporary
CheckOut directory and the Program Manager CheckOut group. Select Yes to delete these

items before closing WinZip. Select No to close WinZip without deleting these items.
Select Cancel to cancel the close operation.



Since most new archives are created in ZIP or LZH format, and there is no single widely
available program to manipulate ARC files, WinZip does not provide facilities to create or
update ARC files. WinZip does support viewing, running, and extracting files in ARCs.



This dialog box is displayed when WinZip cannot run a program. This can happen when a
program specified as a Windows Association was deleted from your system or was moved to
a different drive or directory. The following are the error codes Microsoft has documented:

Value Meaning

0 Out of memory

2 File not found

3 Path not found

5 Attempt to dynamically link to a task

6 Library requires separate data segments for each task

8 Insufficient memory to start application

10 Incorrect Windows version

11 Invalid .EXE file (non-Windows .EXE or error in .EXE image)

12 0S/2 application

13 DOS 4.0 application

14 Unknown .EXE type

15 Attempt in protected (Standard or 386 Enhanced) mode to load an .EXE created for
an earlier version of Windows

16 Attempt to load a second instance of an .EXE containing multiple, writeable data
segments

17 Attempt in large-frame EMS mode to load a second instance of an application that
links to certain nonshareable DLLs already in use

18 Attempt in real mode to load an application marked for protected mode only



WinZip encountered an error trying to view a file. Possible errors include insufficient
memory and 1/O errors.



An incomplete filename was entered. If either a drive or subdirectory is specified, then both
must be specified. For example, the following two filenames are incomplete:

C:PKZIP.EXE
\UTILITY\PKZIP.EXE

In the first example, a drive is specified but no subdirectory is specified. This can cause
unexpected errors if you change the current directory on the C: drive.

In the second example, a subdirectory is specified but no drive is specified. This can cause
unexpected errors if you change the current drive.

Specify a filename like C:\UTILITY\PKZIP.EXE instead. Note that if the file is in a directory
specified by your PATH= environment variable you do NOT need to enter a drive and
directory.



You used the Drag and Drop Interface to drop multiple files onto a WinZip window or icon,
and at least one of these files had an extension of ZIP, LZH, ARJ, or ARC. You'll have to use
the Add Dialog Box to add these files to your archive.




obsolete message (HELP)OLD)



The original release of Norton Desktop for Windows 2.0 does not accept files dropped by
WinZip 4.0. This means you can't drop files onto the NDW desktop, Desktop Item Icons on
the NDW desktop, or NDW group windows. Future versions of NDW, including a possible
update to NDW 2.0, will probably accept files dropped by WinZip. This dialog box is
displayed as a warning that the drop operation may fail because WinZip doesn't know
whether files it drops will be accepted by your version of NDW.

The first time you see this dialog box just press the OK button. The drop operation will
continue, and the Extract dialog box will be activated. After the selected files are extracted,
WinZip will attempt to drop the files on NDW. If NDW does not accept the files, look for an
update to WinZip or NDW in the not too distant future. If NDW accepts the files, select the
checkbox labeled "This version of NDW accepts files dropped by WinZip" the next time this
dialog box is displayed to suppress display of the dialog box in the future.



WinZip could not change to the specified directory, so it is closing the open archive.
Possible causes for this error include removing the directory, or changing disks in the middle
of a WinZip operation.



A serious system error was encountered trying to run the specified DOS command. This
problem is usually caused by a system configuration problem such as using a Windows 3.0

video driver on a Windows 3.1 system, or using buggy video drivers, including "beta test"
video drivers.

If you encounter this error message and are not using a Microsoft supplied video driver, try
installing the VGA driver distributed with Windows to determine if the problem is caused by
a video driver. See the section titled Installing the VGA Driver for instructions.




If WinZip will not run DOS commands (like PKZIP) on your system, the most likely cause is a
faulty video driver. To determine whether a video driver is causing this problem, install the
default Microsoft-supplied VGA driver by following these steps:

1) Read all the steps, and do not perform this procedure unless you are comfortable with
all of them!

2) Double click on SETUP in the Program Manager "Main" group.

3) Select Options/Change System settings

4) Note the name in the "Display" drop down list box. You will need to remember this
name to re-install your existing driver.

5) Select VGA from the "Display" drop down list box

6) Choose OK to install the driver (you will probably need your Windows distribution disks
for this)

After testing WinZip with the VGA driver, you can re-install your video driver by following the
steps above, with one change: specify the name of your video driver in step 5 instead of
using "VGA".

If the VGA driver solves the problem, try to obtain the most recent driver from your video
card vendor. Many video card vendors make their latest drivers available in the GRAPHVEN
forum on CompuServe. Alternately, try the Microsoft Driver Library (GO MDL at the
CompuServe ! prompt or call Microsoft Product Support at 800-426-9400 (voice) or the
Microsoft Download Service BBS at 206-936-6735).

If the above test does not help isolate the problem, or if you are not comfortable installing
the VGA driver, contact the author at the address in the About dialog box for a diagnostic aid
that may help determine the cause of the problem.



WinZip cannot detect errors issued from NAV unless you have DOS version 4.0 or later. If
this is a problem for you, please contact the author at the address in the About dialog box.
See the section titled Virus Scanner Configuration for details on WinZip's interface to virus
scanners.




The NAVW.EXE scanner distributed with Norton Desktop for Windows 2.0 does not provide an
interface for automated scanning, so WinZip can't tell it what files to scan. See the section
titled Virus Scanner Configuration for details on WinZip's interface to virus scanners.




The specified file already exists on disk. Choose Yes to overwrite the file or Yes to All to
overwrite this file and avoid this prompt for all other files during this extract operation.

Choose No to bypass this file and continue the extract operation or Cancel to abort the
extract operation.



WinZip detected that you modified a file after viewing it. Choose Yes to add the modified
file to the archive or No if you don't want to update the archive.



Choose Yes to delete the temporary file or No if you want to keep it. Note that the file
resides in a "temporary" directory specified by your WZTMP=, TMP=, TEMP=, and PKTMP=
environment variables, so you should probably move the file to a "permanent" directory if

you really want to keep it.



WinZip detected that the Control Panel "Exclusive in Foreground" option is selected. This
option prevents WinZip from running DOS programs like PKUNZIP in the background. For
proper WinZip operation, you must turn off this option. Under Windows 3.1 you can do this
as follows: first double click on the Control Panel icon, then double click on the "386

Enhanced" icon; next, click on the "Exclusive in Foreground" checkbox, and finally push the
OK button.



WinZip cannot accept dropped files while the Drop dialog box is active. Close the Drop
dialog box before dropping more files on WinZip.



WinZip requires AR) 2.3 or later. The date of your ARJ.EXE is earlier than 1/19/91, the date
on which ARJ 2.3 was released. Please obtain a newer version of ARJ. See the section titled
System Requirements for information on obtaining the most recent version of AR]J.




This ZIP file does not contain a valid end-of-central-directory record.

If this ZIP is part of a backup set, please insert the last disk of the backup set and try again.
Both PKUNZIP and WinZip need the last disk of the backup set to read the end-of-central-
directory record. You may subsequently be prompted to insert other disks from the backup
set. This is normal PKUNZIP operation and is not specific to WinZip.

If this ZIP is not part of a backup set it may be corrupted. Use the Test option on the Actions
pull-down to test the archive.



This ZIP contains files compressed with PKZIP 2.0. However, your version of PKUNZIP
appears to be older than version 2.0, so the unzip operation will probably fail.
See the section titled System Requirements for information on obtaining the most recent
version of PKUNZIP. See the section titled Built-in ZIP Extraction for a list of reasons
WinZip's built-in ZIP extraction is not used.




The Central Directory for this ZIP spans disks. This version of WinZip does not handle this
situation, so you will have to run PKUNZIP from the DOS command line. Future versions of
WinZip will address this issue.



PKZIP 2.04C cannot create archives on your A: drive if your current drive is A: unless the
PKTMP environment variable is set. There are two solutions to this problem:

1) Add the command SET PKTMP=C:\ to your AUTOEXEC.BAT and reboot.
2) Use a later version of PKZIP. This bug has been corrected in both PKZIP 2.04E and PKZIP
2.04G.



An invalid CheckOut directory was specified. You cannot specify a root directory (e.g. C:\),
and you must specify a drive letter (e.g. C:\CHECKOUT, not just CHECKOUT).



Create File Manager Assocations for ZIP, LZH, ARJ, and ARC files?

Answer Yes to this prompt if you want WinZip to create File Manager Associations so that you
can start WinZip by double clicking on these files. If you answer No the installation will
continue but you will need to open archives using the Open dialog box or the Drag and Drop
interface.



PKZIP disk spanning will replace all files in archive. Continue?

If you choose to continue all files in the archive will be replaced. PKZIPs disk spanning
feature always replaces all files in the archive. PKZIP does not provide an option to avoid

this behavior.



WinZip could not create the specified directory. Possible causes are:

- A file exists with the same names as the directory

- Disk is read-only

- Subdirectories preceding the final subdirectory do not exist. For example, to create the
directory C:\UTILITY\FILES the directory C:\UTILITY must exist.



Due to a limitation in the Windows Program Manager, it is impossible to remove a Program
Manager group while closing Windows. Thus, if you want to remove Program Manager
groups created by WinZip, you need to close WinZip before closing Windows.



PKZIP does not allow the use of the Freshen and Update options while working with archives
that span multiple disks. You have two choices:

1) Change the Multiple Disk Spanning option to No Spanning
2) Use the Add or Move actions instead of Freshen and Update.



